
URDME v. 1.1: User’s manual

Brian Drawert1 Stefan Engblom2 Andreas Hellander2

March 21, 2011

1 Department of Computer Science, University of California-Santa Barbara, Santa Barbara, California

93106, USA, e-mail: bdrawert@cs.ucsb.edu.
2 Division of Scientific Computing, Department of Information Technology, Uppsala University, P. O. Box

337, SE-75105 Uppsala, Sweden, e-mails: stefane@it.uu.se, andreas.hellander@it.uu.se.

Previous contributor: Josef Cullhed (v. 1.0).

Manager of this release: Andreas Hellander (to whom correspondence should be addressed).

1 Introduction

Stochastic simulation methods are frequently used to study the behavior of cellular control
systems modeled as continuous-time discrete-space Markov processes (CTMC). Compared
to the most frequently used deterministic model, the reaction rate equations, the mesoscopic
stochastic description can capture effects from intrinsic noise on the behavior of the networks
[1, 8, 25, 26, 29].

In the discrete mesoscopic model the state of the system is the copy number of the
different chemical species and the reactions are usually assumed to take place in a well-stirred
reaction volume. The chemical master equation is the governing equation for the probability
density, and for small to medium sized systems it can be solved by direct, deterministic
methods [10, 11, 15, 21, 24, 28]. For larger models however, exact or approximate kinetic
Monte Carlo methods [17, 18] are frequently used to generate realizations of the stochastic
process. Many different hybrid and multiscale methods have also emerged that deal with the
typical stiffness of biochemical reactions networks in different ways, see [2, 6, 19, 22, 23, 27]
for examples.

Many processes inside the living cell can not be expected to be explained in a well-stirred
context. The natural macroscopic model is the reaction-diffusion equation which has the
same limitations as the reaction rate equations. By discretizing space with small subvolumes
it is possible to model the reaction-diffusion process by a CTMC within the same formalism
as for the well-stirred case. A diffusion event is now modeled as a first order reaction from
a subvolume to an adjacent one and the state of the system is the number of molecules of
each species in each subvolume. The corresponding master equation is called the reaction-
diffusion master equation (RDME) and due to the very high dimensionality it cannot be
solved by deterministic methods for realistic problem sizes.

The RDME has been used to study biochemical systems in [7, 14]. Here the next subvol-
ume method (NSM) [7], an extension of Gibson and Bruck’s next reaction method (NRM)
[16], was suggested as an efficient method for realizing sample trajectories. An implementa-
tion on a structured Cartesian grid is freely available in the software MesoRD [20].

The method was extended to unstructured meshes in [12] by making connections to the
finite element method (FEM). This has several advantages, the most notable one being the
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ability to handle complicated geometries in a flexible way. This is particularly important in
cell-biological models where internal structures often must be taken into account.

This manual describes the software URDME which provides an efficient, modular im-
plementation capable of stochastic simulations on unstructured meshes. URDME is easy
to use for simulating and studying a particular model in an applied context, but also for
developing and testing new approximate methods. We achieve this by relying on third-party
software for the geometry definition, meshing, preprocessing and visualization, while using
a highly efficient computational core written in ANSI C for the actual stochastic simulation.
This keeps the implementation of the Monte Carlo part small and easily extendible, while
the user benefits from the advanced pre- and post-processing capabilities of modern FEM
software. In this version of URDME, we have chosen to provide an interface to Comsol
Multiphysics 3.5a [3].

The rest of this manual is organized as follows. Section 2 summarizes the major changes
to URDME compared to the earlier version 1.0. Section 3 describes the software require-
ments and the installation procedure. An overview of the code structure is presented in
Section 4 and the details concerning the input to the code, the provided interface to Comsol
and the way models should be specified are found in Section 5. A URDME model is set up
and simulated in a step-by-step manner in Section 6 and in Section 7 we show how a new
core solver can be integrated in the URDME infrastructure.

In two appendices we recapitulate the mesoscopic reaction-diffusion model and show how
the stochastic diffusion intensities are obtained from a FEM discretization of the diffusion
equation. We also list for reference a few stochastic simulation algorithms.

2 Summary of major changes

Below, we summarize the major changes compared to URDME 1.0 [4].

• URDME 1.1 uses Comsol Multiphysics 3.5a to specify the part of the model related to
the geometry. Comsol Multiphysics 3.4 is not supported by URDME 1.1. Of course,
URDME 1.0 is still available for users that only have access to Comsol 3.4.

• The Mex-interface from URDME 1.0 is no longer used in URDME 1.1. Core solvers are
implemented as stand-alone command-line solvers for easier integration of contributed
solvers and greater flexibility when generating results. The communication between
Matlab and URDME is handled via files in the Matlab .mat format.

• Inline propensities are not supported in URDME 1.1.

! The sign convention in the stoichiometric matrix has been changed to ad-
here to the consensus in the systems biology field. Users wanting to port their
old model files from URDME 1.0 must make sure to update N accordingly.
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3 Obtaining and installing URDME 1.1

Usage: URDME is work in progress. You may use, distribute, and modify the code freely
under the GNU GPL license version 3. We welcome suggestions, comments, and bug-reports.
Support questions should be directed to the URDME mailing list, which you can sign up for
on http://www.urdme.org.

3.1 System requirements and software dependencies

• Linux or Apple OSX operating system.

• Matlab

– Tested versions: 2007a, 2008a, 2008b, 2009a, 2009b

– Command line interface must be installed

• Comsol multiphysics 3.5a (with appropriate patches)

– Must have Matlab integration components installed

• GCC (Xcode on Apple computers)

– Executables gcc and make must be in the path

– Standard libraries must be installed

3.2 Installation procedure

1. Obtain the latest release of URDME from http://sourceforge.net/projects/urdme.
Download the file urdme-1.1.tar.gz.

2. Unpack the archive. This can be done by running the command “tar -zxvf urdme-
1.1.tar.gz” in a terminal. Often it is possible to double click the file icon in the
operating system’s graphical file manager.

3. Run the installation script with ‘system administrator’ privileges. In a terminal,
change directory to urdme-1.1 created from the downloaded archive. Run the script
install.sh with ‘root’ or system administrator privileges. This can usually be done
by running the command “sudo ./install.sh”. Follow the prompts of the installation
script, the default values should be sufficient for most users. If the installation script
runs with no errors, URDME should be installed correctly.

3.3 Testing of the installation and Quick start guide

1. Start Comsol and open a model file, e.g. urdme-1.1/examples/mincde/coli.mph.

2. From Comsol, start Matlab:
File > Client/Server/MATLAB > Connect to MATLAB

3. Initialize the Matlab environment.

• Change Matlab’s working directory to the folder for the URDME model you wish
to simulate. At the Matlab command prompt type
>> cd urdme-1.1/examples/mincde/

• Now, initialize URDME by
>> urdme startup

4. Export the model geometry from Comsol to Matlab.
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• Update the Model data:
Solve > Update Model

• Export the data:
File > Export > FEM Structure as ’fem’

5. Simulate the model. At the Matlab command prompt type:
>> fem2 = urdme(fem,’fange’)

6. Visualize the results. At the Matlab command prompt type:
>> postplot(fem2,’Tetdata’,’MinD m’)

7. To manipulate the model, edit the following files:

coli.mph (Comsol model geometry, edited via the Comsol interface)

- Physical geometry and mesh properties
- Names of chemical species
- Diffusion coefficients

fange.m (Matlab pre-processing script)

- Stoichiometric matrix
- Dependency graph
- Initial conditions of chemical species
- Custom diffusion rules (i.e. support for membrane-only species)

fange.c C-functions defining the propensity (rate) of each reaction channel.

A more detailed description on how to set up and simulate this model is found in Section 6.

4 Code overview

URMDE consists of three logical layers. The top layer is made up of an interface to an ex-
ternal mesh generator and pre-/post-processing engine, currently Comsol Multiphysics 3.5a.
The bottom layer is a set of simulation routines, or solvers, written in ANSI C. Interfacing
those two levels is a middle layer implemented in the Matlab environment, designed to fa-
cilitate data processing and visualization, as well as custom model development. Together
these layers form a software package that enables the development and efficient simulation
of complex and powerful models of spatial stochastic phenomena.

The URDME structure is designed with both efficiency and flexibility in mind. A model
is defined by three separate files, one for each of the logical layers. The geometry of the
model is defined in a Comsol .mph file, along with the names and diffusion rates of each
chemical species. A Matlab model file supplies the model with the stoichiometric matrix,
the dependency graph, and the initial state of the system. The stoichiometric matrix defines
the effect of the chemical reactions on the state of the system while the dependency graph
indicates the reaction rates that need to be updated after a given reaction or diffusion event
has occurred. Finally, a model file written in ANSI C specifies the propensity functions for
the chemical reactions in the system. Using compiled rather than interpreted reaction rates
ensures maximum efficiency when simulating the model.

The computational solver that ships with URDME is an efficient implementation of NSM
[7]. Table 4.1 shows the directory structure of URDME together with a short description of
each routine.

A solver has (at least) two arguments: the path to an input file in .mat format and a
name of an output file on which to store the trajectory that is generated. The input file will
contain all the data structures the solver needs, each with its specific name. The URDME
C-core contains utility routines to extract this data from the input file.
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The main steps involved in launching a solver is outlined below, along with the routines
that perform the different tasks. Generally, the user does not have to know or perform
all these steps manually: they are all wrapped in the main routine urdme found in the file
‘urdme.m’. However, users planning to write a plug-in solver for URDME will benefit from
a more detailed knowledge of the code structure. The relevant steps are:

1. Process the .mph model file. This is achieved by exporting the FEM-structure from
Comsol to Matlab and invoking the routine fem2rdme. This will initialize a new
structure, fem.urdme as a field in the original FEM-structure. This structure contains
the fields D, vol, sd, i.e. those data structures related to the geometry of the model
and to the unstructured mesh. Compare Table 4.1.

2. The next step is to invoke the Matlab .m model file to initialize the remaining, essential
data structures, N, G, u0, tspan and optionally data. They should all be added as fields
to the fem.urdme struct. Any modifications of the data structures added to the model
by fem2rdme in the previous step is typically performed in this step as well.

3. After all required fields in the fem.urdme struct have been initialized, urdme validate
is invoked to perform error-checking on the input to make sure that all required fields
in fem.urdme are present and has the correct properties.

4. Next, all fields in fem.urdme is serialized to a .mat input-file using rdme2mat.

5. After specifying the propensities in a ANSI C source file, the solver(s) are compiled
using urdme compile and then launched by a system call from within the Matlab
environment (or directly from e.g. a bash terminal).

6. The input file is now read by the solver, using the utility routine read model found in
‘matmodel.h’. read model allocates, initializes and returns a C-struct urdme model.
This urdme model struct is then the sole input to the routine nsm found in ‘nsm.c’.
nsm unpacks the structure and calls the main simulation routine nsm core found in
’nsmcore.c’. A similar construction should be used by contributed solvers for easy
integration, see Section 7.

7. After successful simulation, the resulting trajectory is written to an output file in .mat
format. This file is then loaded back into Matlab and added to the FEM-struct by
urdme addsol for visualization using Comsol routines or custom Matlab scripts.
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Directory File(s) Description

bin urdme init Environmental variable helper program.

build Makefile GNU Make input file for automatic solver compi-
lation.

Makefile.nsm Makefile for the NSM solver.

comsol fem2rdme.m Matlab-script converting Comsol’s FEM-struct to
a valid urdme-input.

rdme2fem.m Matlab-script for conversion of the output of
urdme to the solution format used by Comsol.

doc manual.pdf The most recent version of this manual.

include matmodel.h Functions to serialize data to/from solvers.
propensities.h Definition of the propensity function datatype.
report.h Header for report.c.

msrc urdme.m Gateway routine for the solvers.
urdme startup.m Initializes URDME.
urdme compile.m Automatic solver compilation.
urdme validate.m Input validation.
rdme2mat.m Serialize model data for input to solvers.
urdme addsol.m Add trajectory to FEM-struct.

src report.c Report function used by urdme.

src/nsm nsm.h Header for the NSM solver.
nsm.c NSM solver interface.
nsmcore.c NSM solver computational core.
binheap.h Header for binheap.c.
binheap.c The binary heap used in the NSM solver.

examples (various) Contains files specifying the example studied in de-
tail in Section 6.

Table 4.1: Overview of the files and routines that make up URDME.

5 Details and specifications

In this section we give a detailed description of the input to urdme and explain how the
coupling between the Comsol/Matlab interface and the solvers works.

5.1 Input to the solver

Table 5.1 summarizes the input to the NSM solver. For precise type definitions, consult the
preamble of the source file ‘nsmcore.c’. While specific for the NSM solver, most of the input
data are likely to be needed by any simulation algorithm. Furthermore, contributed solvers
should preferably accept the same set of input as the NSM solver for compatibility across
models.
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Name Type Description

Ncells scalar (int) Number of subvolumes.
Mspecies scalar (int) Number of different species. This also defines

Ndofs:= Mspecies×Ncells.
Mreactions scalar (int) Number of reactions.
dsize scalar (int) Size of the data vector used in the propensity

function.

u0 Matrix[Mspecies×Ncells]
(int)

u0(i, j) gives the initial number of species i
in subvolume j.

tspan vector (double) An increasing sequence of points in time
where the state of the system is to be re-
turned.

prop Vector[Mreactions]
(PropensityFun)

Propensity function pointers. See Section 5.2
for details.

report ReportFun Pointer to a report function. This function
is called every time the chain reaches a value
in tspan.

vol Vector[Ncells] (double) The volume of the macroelements, i.e. the
diagonal elements of the lumped mass-matrix
M (cf. Appendix A.2).

sd Vector[Ncells] (int) The subdomain numbers of all subvolumes.
See Section 6 for more details.

data Matrix[dsize×Ncells] (dou-
ble)

Generalized data vector. A pointer to col-
umn j is passed as an additional argument
to the propensities in subvolume j.

D Sparse matrix[Ndofs× Ndofs]
(double)

The transpose of the diffusion matrix M−1K
obtained from the FEM discretization of
the macroscopic diffusion equation, cf. (A.5).
Each column in D (i.e. each row in M−1K)
corresponds to a subvolume, and the non-
zero coefficients D(i, j) give the diffusion rate
constant from subvolume i to subvolume j.

N Sparse matrix[Mspecies ×
Mreactions] (int)

The stoichiometric matrix. Each column cor-
responds to a reaction, and execution of re-
action j amounts to adding the jth column
to the state vector.

G Sparse matrix[Mreactions
× (Mspecies+Mreactions)]
(int)

Dependency graph. The first Mspecies

columns correspond to diffusion events and
the following Mreactions columns to reac-
tions. A non-zeros entry in element i of col-
umn j indicates that propensity i needs to be
updated if the event j occurs. See Section 6
for examples.

Table 5.1: Input arguments to urdme. For more details, see the source file ‘nsmcore.c’. All
data in the table will be passed to the core simulation routine via a C-struct urdme model
except prop and report that are specified in separate C files. For all sparse matrices, the
compressed column sparse (CCS) format is used. This is the same format Matlab uses and
online documentation is available.
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5.2 Specifying propensities for chemical reactions

The propensity functions are supplied to urdme as a model file written in ANSI C. The
precise form of the propensity functions is defined by the data type PropensityFun, defined
in the header ‘propensities.h’ (found in the ‘include’ directory) as

typedef double (*PropensityFun)(const int *x, double t, double vol,
const double *data, int sd);

The arguments vol, data, and sd to a PropensityFun are described in Table 5.1. Ad-
ditionally, the input vector x of length Mspecies is the copy number in a given subvolume,
and t is the absolute time. Note that none of the current solvers are capable of simulating
Markov chains with explicitly time-dependent propensities. The time argument is included
in the typedef at this stage only to simplify future developments.

Below is a commented example of a model file defining a simple chemical system com-
posed of a single species X undergoing a dimerization reaction.

/* Propensity definition of a simple dimerization reaction. */
#include <stdlib.h>
#include <stdio.h>
/* Type definition for propensity functions: */
#include "propensities.h"

/* Rate constant. */
const double k = 1.0e-3;

double rFun1(const int *x, double t, double vol, const double *data, int sd)
/* X + X -> 0. */
{
return k*x[0]*(x[0]-1)/vol;

}

PropensityFun *ALLOC_propensities(void)
/* Allocation. */
{
PropensityFun *ptr = malloc(sizeof(PropensityFun));
ptr[0] = rFun1;

return ptr;
}

void FREE_propensities(PropensityFun *ptr)
/* Deallocation. */
{
free(ptr);

}

In addition, any model file must implement the following routines:

• PropensityFun *ALLOC_propensities(void)

• void FREE_propensities(PropensityFun *ptr)

The first function should allocate and initialize an array of function pointers to the propensity
functions and return a pointer to this array. This is the function that the solvers will call
to access the rate functions. The second function should deallocate the pointer ptr. For
further examples, see Section 6.
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6 Example: Min oscillations in E. Coli

In this section we describe the general workflow involved in setting up and simulating a
model in URDME using the Comsol and Matlab interfaces. The major steps are:

1. Specify the model. This involves defining the geometry, mesh, initial conditions and
chemical reactions of the model. In URDME, this will require the generation of three
model files: a Comsol model file ‘model.mph’ , a Matlab model file ‘model.m’ and a
reaction propensity ANSI C file ‘model.c’, where we use model as a placeholder for the
non-extension part of the file-name.

The Comsol model defines the geometric domain of the problem and Comsol Multi-
physics is used to create a mesh representing the spatial discretization of the diffusion
equation with Neumann boundary conditions and the corresponding inter-voxel diffu-
sion jump coefficients. The Matlab model file specifies the chemical reaction networks
of the problem by defining a stoichiometric matrix N and a dependency graph G. The
propensity functions for the chemical reactions are specified in the ANSI C model file.

2. Export the FEM-structure from Comsol to Matlab. After defining the geometry and
using Comsol to create a tetrahedral mesh of the model, the resulting data struc-
ture (FEM) is exported from Comsol to the Matlab workspace via the built-in Com-
sol/Matlab coupling.

3. Run the simulation. The solver is launched from the Matlab workspace via the interface
routine in ‘urdme.m’. As input, you will have to specify the .m and .c model files.
Internally, urdme uses fem2rdme to initialize a field called fem.urdme in the FEM
structure. The function defined in the file ‘model.m’ file then appends data to this
field.

4. Post-processing. After a normal termination of the solver, a trajectory of the stochastic
process will be attached to the FEM structure. At this point, you can use all post-
processing options available in Comsol to visualize the results. If you have other needs
not covered by the built-in routines, you can implement your own post-processing
scripts in Matlab.

To illustrate the above steps in detail, we will reproduce simulations of the Min system
from [14]. The geometry will be a model of an E. coli bacterium. It is rod shaped with
length 3.5µm and diameter 0.5µm. The reactions and parameters of the model can be found
in Table 6.1.

MinD c atp kd−→ MinD m MinD c atp + MinD m kdD−−→ 2MinD m

Min e+MinD m kde−−→ MinDE MinDE ke−→ MinD c adp + Min e

MinD c adp
kp−→ MinD c atp

Table 6.1: The chemical reactions of the MinD/MinE model. The constants take the values
kd = 0.0125µm−1s−1, kdD = 9 × 106M−1s−1, kde = 5.56 × 107M−1s−1, ke = 0.7s−1 and
kp = 0.5s−1.

6.1 Setting up the model for simulation

Defining the geometry and diffusion rates in Comsol The following steps shows
how to create the Comsol model file. If you don’t want to go through all the steps yourself,
open the example file ‘coli.mph’ in the ‘examples/mincde’ folder.
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1. Open Comsol and select ‘Chemical engineering module – Mass transport – Diffusion –
Transient analysis’ (3D). In the ‘Dependent variables’ field write MinD c atp MinD m,
Min e MinDE MinD c adp. These are the names of the variables that we will use. Select
Lagrange – Linear elements and press ‘OK’.

! Note that the ‘Chemical engineering module’ is not required in general for URDME,
but is used in this example for convenience.

2. Next we create the geometry. We will build the rod shaped domain from two spheres
and one cylinder. Press the ‘Cylinder’ button and in the radius and height field enter
0.5e-6 and 3.5e-6 and press ‘OK’. You should now see a cylinder in your workspace.
In the ‘Draw mode’ action bar, press ‘Zoom extents’ in order to get a better view of
the domain. Press the ‘sphere’ button and enter 0.5e-6 in the radius field and press
‘OK’. Create another identical sphere but enter 3.5e-6 as the z-coordinate. Select all
three figures and press the ‘union’ button and then the ‘Delete interior boundaries’
button.

3. Having defined the species and the geometry, the next step is to specify the parameters
in the model. In the menu ‘Physics > Subdomain settings’, choose subdomain 1 and
set the diffusion constants to 2.5e-12 for MinD c adp, MinD c atp and Min e. For
MinDE and MinD m the diffusion constant should be 1e-14.

! MinDE and MinD m are membrane bound species, hence their lower diffusion rates.
We have not specified this explicitly at this stage, but will do so later in the Matlab

model file.

4. In order to be able to distinguish between the interior of the bacterium and the mem-
brane, we must also create two domains. One interior domain that represents the
cytoplasm and one boundary domain that represents the membrane. This is done by
defining the special variable rdme sd as an expression with different value in the dif-
ferent subdomains. It can then be used to distinguish the nodes on the boundary from
those in the interior. Select ‘Options > Subdomain expressions’ and enter rdme sd
with value 1 and click ‘OK’. Select ‘Options > Boundary expressions’ and select all
boundaries (there should be 12 of them). Enter rdme sd with value 2. Finally select
‘Options > Global expressions’ and enter rdme sdlevel with value 2 indicating that
the lowest dimension where rdme sd is defined is on the surface of the geometry.

5. In the ‘Mesh’ menu, select ‘Mesh > Free mesh parameters’ and choose ‘Custom mesh
size’. Set the maximum element size to 1e-7 and press ‘Initialize mesh’. Now select
‘Solve > Update model’. Make sure that you are connected to Matlab, if not, connect
via ‘File > Client/Server/Matlab > Connect to MATLAB’. Then export the FEM
structure to the Matlab workspace from the ‘File > export’ menu.

Specifying the chemical reactions The chemical reactions are specified in a separate
model file written in C. This file will be given as input to URDME, which will compile
and launch a solver. Every time the reaction propensity file is changed, the solver needs to
be recompiled, but this will be automatically detected by URDME. The way the reaction
propensity functions are specified are explained in more detail in Section 5.2, which we
recommend that you read before continuing with this example.

The following code specifies the reaction propensity model .c file for the reactions in
Table 6.1. This file is located in ‘examples/mincde/fange.c’ in the URDME installation
directory. Either open that file, or create a new one of your own, entering the code below.

#include <stdlib.h>
#include "propensities.h"
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/* Ordering of the species. */
#define MinD_c_atp 0
#define MinD_m 1
#define MinD_e 2
#define MinDE 3
#define MinD_c_adp 4

/* Indicator values of sd. */
#define CYTOSOL 1
#define MEMBRANE 2

/* Number of reactions. */
#define NR 5

/* Rate constants. */
const double NA = 6.022e23;
const double kd = 1.25e-8;
const double kdd = 9.0e6;
const double kde = 5.56e7;
const double ke = 0.7;
const double k_adp = 1.0;

/* Reaction propensities. */
double rFun1(const int *x, double t, double vol, const double *data, int sd)
/* MinD_c_atp -> MinD_m */
{
if (sd == MEMBRANE)
return kd*x[MinD_c_atp]/data[0];

return 0.0;
}

double rFun2(const int *x, double t, double vol, const double *data, int sd)
/* MinD_c_atp + MinD_m -> 2MinD_m */
{
return kdd*x[MinD_c_atp]*x[MinD_m]/(1000.0*NA*vol);

}

double rFun3(const int *x, double t, double vol, const double *data, int sd)
/* MinD_m + Min_e -> MinDE */
{
return kde*x[MinD_m]*x[MinD_e]/(1000.0*NA*vol);

}

double rFun4(const int *x, double t, double vol, const double *data, int sd)
{
return ke*x[MinDE];

}

double rFun5(const int *x, double t, double vol, const double *data, int sd)
/* MinD_c_adp -> MinD_c_atp */
{

return k_adp*x[MinD_c_adp];
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}

PropensityFun *ALLOC_propensities(void)
{
PropensityFun *ptr = malloc(sizeof(PropensityFun)*NR);

ptr[0] = rFun1;
ptr[1] = rFun2;
ptr[2] = rFun3;
ptr[3] = rFun4;
ptr[4] = rFun5;

return ptr;
}

void FREE_propensities(PropensityFun* ptr)
{
free(ptr);

}

There are a few points that deserves highlighting:

• Note the unit conversions given explicitly in the bimolecular propensity function. The
rate constants for the bimolecular reactions in this model are given in the unit M−1s−1

and need to be converted to mesoscopic rates. That is why we divide with Avogadros
number times the volume of the subvolume. Also, the way we have set up the geometry
model file, the volume is given in the unit m3, and needs to be converted to L3.
URDME cannot keep track of matching the units between the different model files
automatically: this is the responsibility of the end-user.

• Note how we use the input sd in the first reaction to make sure that it only occurs
in subvolumes lying on the membrane. We have to make sure, however, that we keep
track of what value we assigned to the different subdomains in the Comsol model file
(the value of the expression rdme sd).

• The input t passes the current time to the propensity function. This input is included
in the typedef of the propensity function to make it more general and accommodate
future needs. However, the NSM-solver does not currently handle time dependent
propensities correctly. Thus, the resulting stochastic trajectory will not be a statisti-
cally correct realization of the intended process.

• The first reaction in the model contains a scaling with the local length scale of the
subvolume. For a uniform Cartesian mesh this would simply have been the (constant)
side lengths of the cubes in the mesh. For the unstructured mesh however, this value
will be different in every subvolume. It is readily obtained from Comsol, and is passed
to the propensity function via the data vector data. data will be initialized with the
correct values in the Matlab model file fange.m, next to be described.

Creating a .m model file Before we can run the simulation, we have yet to specify a few
more data structures. We will also need to modify the diffusion rates that we obtain from
the initial Comsol model so that the membrane-bound species only diffuse on the membrane.
We have already prepared for this by labeling the subvolumes next to the boundary using
the expression rdme sd in the Comsol model file ‘coli.mph’.
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Open the file ‘examples/mincde/fange.m’. We will walk through the contents of this file
and explain what the different parts do. Additional information can also be found in the
comments in the file.

1. The stoichiometric matrix. To execute the reactions, the solvers need to know the
stoichiometry of the reactions. This is specified via a sparse matrix N of dimensions
Mspecies × Mreactions. Entry (i, j) in N tells how species i changes upon execution
of reaction j. The following lines of code will set up the stoichiometric matrix for our
example:

% Stoichiometric matrix. Every column corresponds to a reaction.
fem.urdme.N = sparse([-1 -1 0 0 1 ;...

1 1 -1 0 0 ;...
0 0 -1 1 0 ;...
0 0 1 -1 0 ;...
0 0 0 1 -1]);

! Note the change in sign convention in the stoichiometric matrix compared to version
1.0 of this software [4].

2. The dependency graph. Efficient implementations of simulators for large systems uses
a dependency graph to minimize the re-computation of rates. URDME requires that
such a graph G, in the form of a sparse matrix, be submitted to the NSM-solver. It
should have dimensions Mreactions × (Mspecies+Mreactions). The following code
sets up G for this example.

% Dependency graph. The first Mspecies columns indicate the propensities
% that need to be updated when the corresponding species diffuses. The
% next Mreactions columns work analogously for reaction events.
fem.urdme.G = sparse([1 0 0 0 0 1 1 0 0 1;...

1 1 0 0 0 1 1 1 0 1;...
0 1 1 0 0 1 1 1 1 0;...
0 0 0 1 0 0 0 1 1 0;...
0 0 0 0 1 0 0 0 1 1;]);

A non-zero entry at row i in column j means that propensity number i must be updated
if species j diffuses (j ≤ Mspecies) or if reaction j−Mspecies occurs (j > Mspecies).

! A common reason for errors when developing a new model is errors in N or G. A quick
way of setting up the dependency graph is fem.urdme.G = sparse(ones(Mreactions,
Mspecies+Mreactions)). This will make all propensities be recomputed after each
event. While making the code run slower, this is guaranteed to be correct and can be
useful when debugging your model file.

3. The initial condition. There is complete freedom in specifying the initial condition. In
the present case we simply distribute 4002 MinD c atp and 1040 MinE molecules in
some random way in the entire bacterium.

% Specify the total number of molecules of the species.
nMinD = 4002;
nMinE = 1040;

u0 = zeros(Mspecies,Ncells);
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% Random distribution on the voxels specified in the vector ’’all’’.
all = 1:Ncells;

ind = floor(Ncells*rand(1,nMinD))+1;
for i=1:nMinD

u0(5,all(ind(i))) = u0(5,all(ind(i)))+1;
end

ind = floor(Ncells*rand(1,nMinE))+1;
for i=1:nMinE

u0(3,all(ind(i))) = u0(3,all(ind(i)))+1;
end

fem.urdme.u0 = u0;

Note that the code above does not produce a uniformly random initial distribution
since the volume of each voxel is not taken into account.

4. Specifying the times to output the state of the system. URDME will look for a vector
tspan to determine when to output the state of the trajectory (the number of events
generated in a typical realization often exceeds 109 so we can’t output after each event).
Here, we want to sample the system on the time interval [0, 200s], with output each
second. This is achieved by:

fem.urdme.tspan = 0:200.

5. Membrane diffusion. In order to make MinD m and MinDE diffuse only on the
membrane, we will zero out all elements in the diffusion matrix that are in the cytosol.
To obtain indices of those subvolumes we use the information in the subdomain vector
sd. sd will be generated by the urdme interface upon calling the solver interface, and
will contain the information encoded in the expression rdme sd in the Comsol model
file. For more details, see Section 5.

pm = find(fem.urdme.sd == 2);
cyt = find(fem.urdme.sd == 1);

Remember that we gave rdme sd the value 2 on the membrane and 1 in the interior.
The diffusion matrix D will contain the rate constants for the diffusive events on the
unstructured mesh. D is also generated from the Comsol model file when calling the
solver, and will be available to the .m model file in fem.urdme.D. To (efficiently) zero
out the correct entries in D, we first decompose the sparse matrix, find the entries
using pm and cyt above, and then reassemble the matrix again (compensating for the
removed entries by adjusting the diagonal of the matrix). All in all, the code to do
this is as follows:

% For MinD_m (2) and MinDE (4), flag all dofs in the cytosol for
% removal.
ixremove = [];
for s = [2 4]
ixremove = [ixremove; Mspecies*(cyt-1)+s];

end
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D = fem.urdme.D’;

% Decompose the sparse matrix.
[i,j,s] = find(D);

% Set all elements in the diffusion matrix corresponding
% to the cytosol to zero.
ixremove = [find(ismember(i,ixremove)); find(ismember(j,ixremove))];
i(ixremove) = [];
j(ixremove) = [];
s(ixremove) = [];

% Reassemble the sparse matrix and adjust the diagonal entries.
ixkeep = find(s > 0);
D = sparse(i(ixkeep),j(ixkeep),s(ixkeep),Ndofs,Ndofs);
d = full(sum(D,2));
D = D+sparse(1:Ndofs,1:Ndofs,-d);

fem.urdme.D = D’;

! It is of fundamental importance that the columns of D sum to zero, and that all off-
diagonal entries are positive. For an introduction to how D is constructed, see Appendix
A. For a detailed account, consult [12].

! The way we have modeled membrane diffusion is simply by saying that the subvolumes
closest to the membrane constitute the membrane layer. As the mesh becomes finer
near the boundary, the thickness of this layer will decrease, eventually approaching a
2D model of the membrane. One can think of other ways of modeling the membrane
diffusion. The most obvious is to explicitly draw the membrane as a separate (true)
subdomain with a fixed thickness in the Comsol model file. This would usually mean
that more subvolumes are needed to resolve that thin layer.

6. The generalized data vector. Finally, we need to set fem.urdme.data to contain the
values of the length parameter for the subvolumes (it is needed in the first reaction,
rFun1). To do this, we use the built-in Comsol function postinterp which can be
used to evaluate an expression in any point in the domain. Here, we simply get the
subvolume sizes by using the pre-defined expression h, evaluated in the vertices of the
mesh.

% postinterp is a Comsol function that evaluates an expression at a
% set of points. The predefined expression ’h’ can be used to obtain
% the local length of each subvolume.

dofs = xmeshinfo(fem,’Out’,’dofs’);
fem.urdme.data = postinterp(fem,’h’,dofs.coords(:,1:Mspecies:end));

! The ordering of the vertices in the mesh in the FEM structure (e.g. fem.mesh.p) is
not necessarily the same as the ordering in Comsol’s extended mesh format of the de-
grees of freedom. To ensure that the ordering is consistent between these two structures
we can alternatively transform them using the following method:

dofs = xmeshinfo(fem,’Out’,’dofs’);
data = postinterp(fem,’h’,fem.mesh.p);
fem.urdme.data = data(dofs.nodes(1:Mspecies:end));
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For more details concerning the internal ordering of the dofs, consult the Comsol user’s
manual. The interface routines fem2rdme and rdme2fem also contain useful informa-
tion on this matter.

6.2 Running the simulation

With all three model files set up correctly, we are now ready to launch the simulation. In
Matlab, change the current working directory to ‘examples/mincde’ (or if you have prepared
your files in another directory, to that one). Initialize URDME by calling

>> urdme_startup;

Next, to launch the simulation, call the main interface routine in ‘urdme.m’:

>> fem = urdme(fem,@fange,{’Propensities’,’fange’});

URDME will now extract information from the Comsol and Matlab model files, compile
the solver with linking to the propensities specified in fange.c, and then execute the solver
by making a system call.

6.3 Post-processing

If the simulation in the previous step completed without errors, the model structure will
now contain a realization of the stochastic process. To visualize the trajectory, we can use
any of the visualization options available in Comsol or we can create routines of our own.
To look at the MinD m distribution on the membrane at the final time we can use Comsol’s
postplot:

>> postplot(fem,’Tetdata’,’MinD_m’);

To visualize the result at any other time, e.g after 100s:

>> postplot(fem,’Tetdata’,’MinD_m’,’T’,100);

! You can specify any time in the interval you simulated, but if you specify a time that
lies between two points in tspan Comsol will do interpolation to approximate the result at
that point.
To visualize a species inside the domain, we can do as follows:

>> postplot(fem,’Slicedata’,’MinD_c_atp’);

There are many more options that can be passed to postplot to control the plot produced.
For a detailed account , see the Comsol documentation:

>> help postplot

If you prefer to work within the Comsol GUI for visualization, you can import the FEM
structured with the attached stochastic trajectory back into Comsol. We have added a field
to the structure, fem.urdme, and Comsol does not recognize this data. Before importing,
we need to make a copy of our structure where we have removed the URDME specific data.
This is achieved by

>> fem2 = rmfield(fem,’urdme’);

Then, from the Comsol GUI, import the new structure (fem2): ’File > Import > FEM
structure...’. You can now visualize the trajectory using the menu ’Postprocessing > Plot
Parameters’.
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7 Integrating solvers with URDME

In this section we will describe how to integrate a third party spatial stochastic solver into
URDME using the DFSP [5] plugin as an example. URDME plugins have three main
components: the makefile, the solver executable, and (optionally) a pre-execution script.
Each part is described in Table 7.1 where the files that make up the DFSP solver are
explained. We recommend that developers follow this format when integrating their own
solvers.

Directory File(s) Description

build Makefile.dfsp Solver makefile, for building the solver automati-
cally when calling urdme. The name of this file is
very important: the automatic compilation process
looks for a makefile that is suffixed with the name
of the solver (in lower case). This makefile com-
piles the solver with the model’s propensity func-
tions into the low-level executable which is called
by the middle-level interface.

src/dfsp dfsp.c Solver entry point and data initialization code.
Contains a main-function and setup routines for
the data structures. The initialization procedure
takes the .mat file (which is a serialization of the
fem.urdme structure from the Matlab workspace)
and instantiates a urdme model struct (defined in
include/matmodel.h).

dfsp.h Header file containing all function prototypes nec-
essary for DFSP.

dfspcore.c Main entry point for the solver: the function
dfsp core.

dfsp reactions.c Helper function to process reaction events.
dfsp diffusion.c Helper function to process diffusion events.

msrc urdme init dfsp.m Pre-execution script to initialize data structures
before the solver is called. When executing
a model with a specified solver, the URDME-
interface looks for a Matlab-function named
urdme init <solver> (that is, in the file ‘ur-
dme init <solver>.m’).

Table 7.1: Overview of the files that make up the DFSP plugin solver.

When the middle level interface calls the solver executable, it passes all model and
geometry data to the solver via a .mat data file. The names of the input file and the output
file are both specified as command line arguments (i.e. in the argv parameter to the main
function). The core URDME distribution includes routines to read and parse this data file
into a C-language struct (see the header file ‘matmodel.h’). The solver is then called with
the model struct as a parameter. Once the solver has finished simulating the model, it
attaches the calculated solution trajectory to the model structure. The solution trajectory
is then serialized to the output file using supplied routines (see ‘urdme.m’). When the
solver has completed its execution, the middle level interface imports the serialized solution
trajectory and makes it available to the post-processing and visualization routines. The
logical separation of solvers from the rest of the URDME software enables streamlined
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development and debugging of new computational methods.
For efficient simulation of URDME models, it is necessary to compile the model specific

propensity functions with the routines of the solver chosen to perform the simulation. The
solver specific makefiles are responsible for this compilation. For illustration we will use
the DFSP plugin and the “mincde” model as an example (i.e. replace ‘dfsp’ with the name
of the solver you wish to integrate). From the middle-level Matlab interface, when the
urdme function is called with the parameter {’Solver’,’dfsp’}, URDME attempts to
compile the executable ‘urdme/fange.dfsp’ from the propensity function file ‘fange.c’ and
solver files using the compilation specified in ‘Makefile.dfsp’ in ‘urdme/build’. The makefile
is responsible for all necessary steps of the compilation process and the target executable is
built in the ‘urdme’ subdirectory of the current working directly, and is named according
to the propensity file (‘fange.c’) and solver DFSP, thus ‘urdme/fange.dfsp’. The automatic
compilation process is designed for ease of use from the middle-level Matlab interface.

Often spatial stochastic simulation methods require additional processing of geometry
and model data before execution can proceed. In URDME, this is accomplished through
the use of a specifically named Matlab function found in the ‘urdme/msrc’ subdirectory of
the URDME distribution. For the DFSP plugin, this file is named ‘urdme init dfsp.m’. The
function defined in this file must take as arguments the fem data structure and a variable
number of additional arguments (i.e. varargin). If urdme is called with solver arguments,
that cell-vector is passed as the second argument to this function. Implementation of a pre-
processing script provides method developers with a powerful and flexible way to perform
any necessary data transformations for their specific solvers.
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A Stochastic chemical kinetics

In this section we briefly describe how reaction and diffusion events are modeled and how
we obtain the diffusion rate constants when the domain is discretized using an unstructured
mesh. For a more detailed introduction to the subject along with many additional references,
consult e.g. [9].

The computational core of URDME is based on the next subvolume method (NSM) [7].
Details concerning the actual simulation algorithms can be found in Appendix B.

A.1 Mesoscopic chemical kinetics

In a well-stirred chemical environment reactions are understood as transitions between the
states of the integer-valued state space counting the number of molecules of each of D
different species. The intensity of a transition is described by a reaction propensity defining
the transition probability per unit of time for moving from the state x to x + Nr;

x
ωr(x)−−−→ x + Nr, (A.1)

where Nr ∈ ZD is the transition step and is the rth column in the stoichiometric matrix N .
Eq. (A.1) defines a continuous-time Markov chain over the positive D-dimensional integer
lattice.

When the reactions take place in a container of volume Ω, it is sometimes useful to know
that the propensities often satisfy the simple scaling law

ωr(x) = Ωur(x/Ω) (A.2)

for some function ur which does not involve Ω. Intensities of this form are called density
dependent and arise naturally in a variety of situations [13, Ch. 11].

A.2 Mesoscopic diffusion

In the mesoscale model, a diffusion event is modeled as a first order reaction taking species
Sl in subvolume ζi from its present subvolume to an adjacent subvolume ζj ,

Sli
aijxli−−−−→ Slj , (A.3)

where xli is the number of molecules of species l in subvolume i. On a uniform Cartesian
mesh such as those used in MesoRD [20], the rate constant takes the value aij = γ/h2 where
h is the side length of the subvolumes and γ is the diffusion constant. In URDME we use
an unstructured mesh made up of tetrahedra and the rate constants are taken such that
the expected value of the number of molecules divided by the volume (the concentration)
converges to the solution obtained from a consistent FEM discretization of the diffusion
equation

ut = γ∆u. (A.4)

Using piecewise linear Lagrange elements and mass lumping, we obtain the discrete problem

ut = M−1Ku (A.5)

where M is the lumped mass matrix and K is the stiffness matrix. The rate constants on
the unstructured mesh are then given by

aij =
1
Ωi

kij , (A.6)

where Ωi is the diagonal entry of M and can be interpreted as the volume of the dual element
associated with mesh node i (see Figure A.1). For more details, consult [12].

The assumption made in the mesoscopic model is that molecules are well-stirred within
a dual cell. These dual cells correspond to the cubes of the staggered grid in a Cartesian
mesh.
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Figure A.1: A 2D example of an unstructured triangular mesh. The primal mesh is shown
in dashed and the dual in solid. Within each dual element the system is assumed to be
well-stirred, and molecules can jump from each dual cell to the neighboring ones.

B Algorithms

One of the most popular algorithms to generate realizations of the CTMC in the well-stirred
case is Gillespie’s direct method (DM) [17]. Several algorithmic improvements of this method
exist, one of them being the next reaction method (NRM) due to Gibson and Bruck [16].

The underlying algorithm in URDME is the next subvolume method (NSM) [7]. The
NSM can be understood as a combination of NRM and DM in order to tailor the algorithm
to reaction-diffusion processes.

For reference, we first state below both DM and NRM and then outline NSM.

Algorithm 1 Gillespie’s direct method (DM)
Initialize: Set the initial state x and compute all propensities ωr(x), r = 1, . . . ,Mreactions.
Also set t = 0.
while t < T do

Compute the sum λ of all the propensities.
Sample the next reaction time (by inversion), τ = − log(rand)/λ. Here and in what
follows, ‘rand’ conveniently denotes a uniformly distributed random number in (0, 1)
which is different for each occurrence.
Sample the next reaction event (by inversion); find n such that∑n−1

j=1 ωj(x) < λ rand ≤
∑n

j=1 ωj(x)
Update the state vector, x = x + Nn and set t = t + τ .

end while
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Algorithm 2 Gibson and Bruck’s next reaction method (NRM)
Initialize: Set t = 0 and assign the initial number of molecules. Generate the dependency
graph G. Compute the propensities ωr(x) and generate the corresponding absolute waiting
times τr for all reactions r. Store those values in a heap H.
while t < T do

Remove the smallest time τn = H0 from the top of H, execute the nth reaction x :=
x + Nn and set t := τn.
for all edges n → j in G do

if j 6= n then
Recompute the propensity ωj and update the corresponding waiting time according
to

τnew
j = t +

(
τold
j − t

) ωold
j

ωnew
j

.

else {j = n}
Recompute the propensity ωn and generate a new absolute time τnew

n . Adjust the
contents of H by replacing the old value of τn with the new one.

end if
end for

end while

Algorithm 3 The next subvolume method (NSM)

Initialize: Compute the sum σr
i of all reaction rates ωri and the sum σd

i of all diffusion
rates aijxsi in all subvolumes i = 1, . . . , Ncells. Compute the time until the next event in
each subvolume, τi = − log(rand)/(σr

i + σd
i ), and store all times in a heap H.

while t < T do
Select the next subvolume ζn where an event takes place by extracting the minimum
τn from the top of H.
Set t = τn.
Determine if the event in ζn is a reaction or a diffusion event. Let it be a reaction if
(σr

n + σd
n) rand < σr

n, otherwise it is a diffusion event.
if Reaction event then

Determine the reaction channel that fires. This is done by inversion of the distribution
for the next reaction given τn in the same manner as in Gillespie’s direct method in
Algorithm 1.
Update the state matrix using the (sparse) stoichiometric matrix N .
Update σr

n and σd
n using the dependency graph G to recalculate only affected reaction-

and diffusion rates.
else {Diffusion event}

Determine which species Sln diffuses and subsequently, determine to which neigh-
boring subvolume ζn′ . This is again done by inversion using a linear search in the
corresponding column of D.
Update the state: Snl = Snl − 1, Sn′l = Sn′l + 1.
Update the reaction- and diffusion rates of subvolumes ζn and ζn′ using G.

end if
Compute a new waiting time τn by drawing a new random number and add it to the
heap H.

end while
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